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Вопрос - Ответ 
Выделяю несколько объектов (линии, текст) при помощи Shift, нажимаю на клавиатуре delete - 
реакция номер ноль, т.е. ничего не удаляется, объекты по прежнему выделены. нажимаю 
Delete еще раз и еще раз... удаляется только на 3, 4 или 5 раз. 
Клавиша Shift в ZWCAD используется для снятия выделения.  
Выделить объекты можно простым кликом мышки на них или "натянув" рамку выделения. 
Причём, существует два типа рамок: зеленая (пунктирная, тянется влево) и синяя (сплошная, 
тянется вправо). Отличие состоит в том, что зеленая рамка выделяет все объекты, любая часть 
которых попала в неё, а синяя выделяет только объекты полностью попавшие в нее. 
 
Как в многострочном тексте выравнивать по ширине и высоте? 
Встроенный редактор многострочного текста (команда _mtext) с лёгкостью осуществляет все 
вышеперечисленные операции. Только их необходимо выбрать в выпадающем меню, нажав 
правую кнопку мыши во время редактирования. 
 
Как посчитать площадь? 
Команда Area и следовать указаниям командной строки.  
Также можно начертить любой замкнутый объект, например, полилиниями и посмотреть его 
площадь в окне свойств (Area). Если фигура начерчена линиями (line) их необходимо 
переконвертировать в полилинии: 
1. переконвертировать линии в полининии: pe, Multiple, выделить все линии 
2. соединить нескольких полилиний в одну: pe, Join 
 
Появится ли в ZWCad функция, аналог "Объединить" для соединения нескольких полилиний в 
одну с общей длиной? 
Данная операция реализована. Для объединения полилиний или для преобразования обычных 
линий в полилинию используйте команду редактирования полилиний (_pe или _pedit). Далее 
необходимо выбрать опцию Join и следовать указаниям командной строки. 
 
Поддерживаются ли TTF-шрифты? 
ZWCAD поддерживает TTF-шрифты. Он импортирует их из Windows, т.е. из папки 
windows/fonts, поэтому нужные Вам шрифты необходимо размещать именно там или 
устанавливать через Панель управления Windows. 
 
Screen Menu в AutoCAD оно постоянно висит на экране, а в ZwCAD-е, как я понял, оно 
всплывает по необходимости. Это так и должно быть или все-таки можно сделать, чтоб было 
как в AutoCAD? 
Screen menu можно включить в настройках. Команда OPTIONS (или через меню Tools -> 
Options) вкладка "Diplay" галочка Display Screen Menu. Меню будет появляться в момент 
работы команд для выбора опций. 
 
Вопрос по инструменту "отражение" и текст. Текст отражается оптически, а AutoCAD в этой 
ситуации спрашивает, надо ли разворачивать текст (т.е. оставить его читаемым). Это 
излечимо? 
Отражать (т.е. переворачивать) или не отражать текст определяется в переменной MIRRTEXT. 
Если она включена, то при MIRROR текст переворачивается и становится не читаемым, если 
выключена, то зеркально меняется выравнивание текста. 
 
Как восстановить файлы в случае аварийного завершения программы? 
Программа ZWCAD сохраняет чертежи при работе с ними.  
В случае аварийного завершения программы (вылетания, зависании компьютера и т.п.) файлы 
можно восстановить двумя способами: 
1. Настроить автосохранение. Tools -> Options (или командой options) -> Вкладка Open and 
Save -> Раздел File Safety Precaution -> снизить интервал автосохранения в минутах  
2. Восстановить из временных файлов. По умолчанию временные файлы создаются в 
C:\Documents and Settings\<имя_пользователя>\Local Settings\Temp\ с расширение SV$. Их 
можно скопировать в нужную директорию и заменить расширение SV$ на DWG. Настроить пути 
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сохранения временных файлов можно в настройках программы: Tools -> Options (или командой 
options) -> Вкладка Files -> Temporary File Search Path 
 
Как убрать подсказки? 
Убери галочку Display Smarttrack tooltips в Tools->Options закладка Drafting. 
 
Часть пользователей работает на светлом фоне, часть - на темном. Приходится просматривать 
и те и другие чертежи. Как быстро сменить фон для Graphic Screen? 

Код пишется в командную строку, свое дело делает. Можно повесить на кнопку 

 (if (= (getvar 'BKGCOLOR) -1) (command "_setvar" "BKGCOLOR" "0") (command "_setvar" 
"BKGCOLOR" "-1")) 

 
Каковы особенности работы ZWCAD в 3D? 
Особенность 3D черчения в ZWCAD заключается в следующем: 
После выбора вида View (Top / Bottom / Left / Right / Front /Back или любого другого), в 
котором нужно чертить, следует выставить пользовательскую систему координат (ПСК), и 
после этого чертить в измененных координатах XY. При черчении в другом виде, опять 
изменить ПСК. 
 
Как создавать кнопки панели? 
Из главного меню: Tools - Customize - Toolbars (команда tbconfig) 
Если требуется создать новую панель, то кнопка New, в поле вводим имя панели, затем ОК 
2. Левой кнопкой мыши с нажатым Ctrl переносим любую кнопку в новую панель. 
3. Щелкаем правой кнопкой мыши на перенесенной кнопке, выбираем Modify. 
4. Вводим имя, команду, строку помощи в соответствующих полях; жмем ОК 
5. Меняем иконку правой кнопкой мыши через Edit Button Image или Change Button Image 
Если требуется создать кнопку в существующей панели, то жмем правую кнопку мыши на 
существующей кнопке и выбираем пункт Insert 
 
Следующая проблема. Zwcad запускается, спрашивает про систему измерений и после нажатий 
клавиши ОК, вырубается, не сказав ни слова! В чем дело? 
Это вирус! Находится в автозагрузке, файл windows/system32/amvo.exe. Когда 
отключите этот процесс в автозагрузке - всё запуститься без затруднений! Потом необходимо 
полечить антивирусом.  
 
Как задать папку временного хранения чертежей?  
Дело том, что ZwCAD, как и многие другие, создает временный файл в системной папке Temp не 
в C:\Windows\Temp, а в пользовательской папке, например, C:\Documents and 
Settings\Пользователь\Local Settings\Temp. ZwCAD, как и многие другие программы, имеют в 
связи с этим баг: то ли из-за слишком длинного пути, то ли из-за наличия символов кириллицы - 
путь обрабатывается неправильно. Выход из положение стандартный - меняем пути временных 
папок. То есть "C:\Documents and Settings\Пользователь\Local Settings\Temp" меняем на тот же 
"C:\Windows\Temp". Сделать это можно так: Пуск => Свойства "Мой компьютер" => Вкладка 
"Дополнительно" => Кнопка "Переменные среды" => ... Видим два окошка: Переменные среды 
пользователя и системные переменные среды. Находим в системных переменных пользователя 
переменную "Temp" или "Tmp", кликаем "Изменить" и копируем ее значение 
"%SystemRoot%\TEMP". Далее заходим в верхнее окошко и находим также переменные "Tmp" и 
"Temp", и меняем значения по умолчанию значением, хранящимся у нас в буфере обмена. 

Как загрузить приложение LISP? 
Загрузить коды LISP, находящиеся на нашем форуме можно в несколько этапов.  

1. СОХРАНЕНИЕ КОДА LISP  

С помощью курсора выделяем этот код и копируем его в буфер обмена, нажав правую кнопку 
мыши и выбрав пункт Копировать (или Ctrl+C). 

http://forum.zwsoft.ru/viewtopic.php?f=17&t=252&sid=2a34bf1225645f62ed7426624e4e17c7#p1083#p1083
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Запускаем "Блокнот" и вставляем наш код с помощью меню Правка >> Вставить (или Ctrl+V)\  

;;VIEW COMMANDS (vs, vr, vst, vrt) 
(defun c:vs() ;;Saves view (of name to be supplied by user). 
(command "-v" "s")) 
(defun c:vr() ;;Use this to restore Named View created by 'vs' (Type in the name supplied earlier) 
(command "-v" "r")) 
(defun c:vst() ;;Creates view called 'temp'. 
(command "-v" "s" "temp")) 
(defun c:vrt() ;;Restores view "temp" 
(command "-v" "r" "temp")) 

Открываем Блокнот и вставляем скопированный код с помощью меню Правка >> Вставить (или 
Ctrl+V). Файл сохраняем с любым именем, например, start и обязательно расширением lsp 
после точки. Получам start.lsp. Не забываем, куда сохранили файл - этот путь понадобится. 
Рекомендуется для LISP программ создать отдельную папку, где их и хранить.  

2. ЗАГРУЗКА в ZWCAD  

Необходимо запустить ZWCAD. В командной строке набрать команду _appload. В появившемся 
окне нажать кнопку Add File. Найти сохраненный файл start.lsp (для этого и запоминали путь 
сохраненного файла) и выбрать его. В окне нажать кнопку Load (Загрузить). Кнопкой Add to 
statup suite можно назначить автоматическую загрузку кода при запуске ZWCAD. После всех 
операций нажать кнопку Ok.  

3. ЗАПУСК КОДА LISP в ZWCAD  

В командной строке ZWCAD набирается команда, находящаяся после (defun c:. Такие образом 
после загрузки приведенного в примере кода можно использовать четыре разных команды vs, 
vr, vstи vrt.  

Удачного использования!  

 

У меня есть код VBA от AutoCAD. Как мне его перенести в ZWCAD? 

Чтобы перенести код VBA от AutoCAD, необходимо проделать следующее:  

1. Из VBA редактора AutoCAD скопировать код в VBA редактор ZWCAD. 
2. Код следует модифицировать с соответствии с Руководством разработчика.  

Руководство разработчика программы вызывается из программы ZWCAD через главное 
меню Help - Developer Help. 
 

СОВЕТЫ по работе в ZWCAD 
 
Для указания точек объектной привязки (Object snap) не обязательно вытаскивать панель с 
одноимённым названием. Во время выполнения любой команды достаточно нажать 
комбинацию Shift+Right click и откроются все возможные способы привязки. 
Можно нагрузить сразу несколько часто употребляемых привязок, поставив птички в 
нескольких квадратиках. Описанным в цитате способом надо брать редко употребляемые 
привязки. 
 
В ходе указания точек объектной привязки и при использовании трекинга (Object snap 
tracking), можно циклически перебирать все близлежащие к курсору на экране точки 
привязки, нажимая клавишу Tab. Совет работает даже при отключённом режиме Tracking'a, 
который временно включается! 
 

http://forum.zw-cad.ru/viewtopic.php?f=16&t=163&start=0&st=0&sk=t&sd=a
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Работают стандартные клавиатурные сокращения Windows. Например Ctrl+С - копировать в 
буфер, Ctrl+X - вырезать в буфер, Ctrl+V - вставить из буфера, Ctrl+Z - отменить 
последнюю(ие) команду(ы).  
 
У всех команд в Каде есть "свои" клавиатурные сокращения (aliases), набрав которые и нажав 
Enter или Space можно вызвать соответствующую комманду. Например, с - circle, l - line, co - 
copy, h - штриховка и т. д. и т. п. 
 
Указание углов поворота объектов направлениями на север (N), юг (S), запад (W) и восток(E) 
E=0 градусов, N=90, W=180 и S=270 градусов. Если на запрос введите угол набрать N -то 
объект повернется на 90 градусов против часовой стрелки и т. д. относительно своего 
текущего положения при стандартных настройках направлений углов. Также можно указывать 
отрицательное направление. 
 
Есть не очень популярная команда Construction Line - бесконечная линия. Ею мало кто 
пользуется,а зря! Такой многоцелевой шаблон. Даёт вертикаль, горизонт, биссектрису, 
заданный угол и offset. Удобно то, что всегда достанет до любой точки, а лишнее и обрезать 
можно! 
 
Если требуется нарисовать следующий объект, перенести объект относительно какой-то 
выбранной точки, в командной строке пишем координаты относительно данной точки 
декартовы 200,200 или полярные - сначала угол в градусах <-30 , потом расстояние - 200; или 
можно сразу -@расстояние<угол, если координаты полярные; @радиус<угол,элевация по 
аппликате - если координаты цилиндрические; @радиус<угол1<угол2 - если координаты 
сферические; 
 
Оригинальный способ вычисления площади: 
1. Создаем новый слой. 
2. Команда boundary. В вылетевшем окне жмем pick. Указываем точки внутри всех помещений, 
площадь которых хотим определить. Заканчиваем команду enter или right click. 
3. Получаем в текущем слое набор полилиний, площадь которых поочередно сморим в окне 
properties 
 
Если при загруженном ZWCAD редактировался файл zwcad.pgp, то для его (файла) 
инициализации необязательно ZWCAD перегружать - достаточно выполнить команду _REINIT 
 
Ctrl+Tab - Переключение между окнами 
 
Двойной щелчок по колесу мыши - видим все, что есть на экране... 
 
Используйте кнопки Up и Down для повторного ввода значений или текста в командной строке 
 
Для чистки файлов от неиспользованных примитивов регулярно пользуйтесь командой purge. С 
командной строки pu. В меню живёт здесь: File -> Drawing Utilities -> Purge (Файл - Утилиты - 
Очистить) 

 
Чтобы продолжить чертить из последующей линии, достаточно нажать два раза Enter.   
 
Одно из самых полезных сочетаний клавиш, которое действует практически во всех 
приложениях Windows - это CTRL + S = сохранение документа (от англ. Save - сохранить). 
Особенно полезно при работе в нестабильных условия (вылетание из программы, отключение 
"света" и т.п.). 
 
Для распечатки чертежей "без проблем" использовать просмотрщик dwg файлов Autodesk DWG 
TrueView. Он совершенно бесплатен и полностью сделан на AutoCAD. Установить его можно с 
демо-диска компании «СофтИНсайд». 
 
Иногда в фалах, созданных в AutoCAD и открытых в ZWCAD, множественные области просмотра 
в пространстве листа оказываются заблокированными и работа с ними не представляется 
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возможной. В этом случае, рекомендую воспользоваться командами _pspase/_mspase, что 
позволяет работать с пространством листа. 
Если вкратце Layout работает так: нужно, создать Layout из нужного Вам шаблона (например, с 
рамкой и штампом), а затем внутри организовать видовые экраны Viewport. 
 
ОЧЕНЬ РЕКОММЕНДУЕТСЯ с файлом, пришедшим из AutoCAD, поступить так - выделить все, 
скопировать и вставить в новый, уже по zwcadовскому шаблону! 
 
Все настройки ZWCAD можно экспортировать и импортировать. Очень удобно, когда за одной 
машиной работают несколько пользователей, или ведутся работы над различными типами 
чертежей. OPTIONS - > Вкладка Profiles. Таким образом, можно создать необходимую 
конфигурацию и устанавливать её на всех ZWCAD на предприятии. Очень удобно. 

 
Для увеличения производительности ZWCAD можно попробовать настроить различные 
параметры отображения: 
Tools -> Options (или сразу команда _options) -> вкладка Display -> группа Display Perfomance 
и Display Resolution 
 
Если вы имеете дело с "левыми" dwg-файлами, полученными от смежников или ещё не весть 
откуда, то велика вероятность, что при открытии таких файлов и при работе с ними ZWCAD 
рухнет (по крайней мере, такая проблема проявляется в AutoCAD). Крах может быть вызван 
тем, что чертеж был выполнен с использованием сторонних приложений типа СПДС Graphics, 
autoSPDS и т.п. 
Чтобы обезопасить себя от душевных потрясений и потери наработок за последние XX часов, 
попробуйте применить следующую методику: 

• с собственными (стабильными) dwg-файлами работайте, как обычно (открывая их всё в 
том же ZWCAD-е, переключаясь через вкладки или через Ctrl+Tab);  

• а для "левых" файлов подгрузите отдельную копию приложения ZWCAD, и открывайте 
чужие (нестабильные) файлы в нём через меню "File" - "Open...");  

• между отдельными ZWCAD-ами переключайтесь через панель задач Windows (то что 
внизу экрана) или используя Alt+Tab. 

Суть в том, что если "левый" файл обрушит отдельно запущенную копию приложения ZWCAD, 
то вашего основного ZWCAD-а крах не коснется. 
 
Используйте различные шаблоны для ZwCAD. Их можно использовать в самом начале работы 
при создании чертежа. Для этого необходимо распаковать архив в директорию \Template 
ZwCAD-а. Значения полей разработал-проверил и т.д. меняются в редакторе атрибутов блока, 
который можно вызвать двойным кликом по рамке на листе. При необходимости шаблон можно 
изменить (например добавить ГИП, ГАП и т.д.) в редакторе блока. 
 
Программа ZwCAD постоянно дорабатывается разработчиками. Обязательно устанавливайте 
все обновления (UPDATE), новые версии (с индексом, например i) и т.д. Получить их можно в 
офисе компании «СофтИнсайд» (г. Краснодар, ул. Тургенева 56, оф. 4) или в Интернете по 
адресу: http://www.softinside.ru/zwcad.html.  
 
Если Вы не нашли ответ на свой вопрос, обращайтесь: 

• Компания «СофтИнсайд» +7 (861) 251-16-30, 253-47-23 
• Техподдержка ZwCAD +7 (863) 270-27-62 
• Форумы http://forum.zwsoft.ru/  

При создании документа использовались материалы сайта www.zwsoft.ru 
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